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1 Contact Details 

ADR1 is designed and manufactured by Emvexis Limited. 

Emvexis Limited is registered in England and Wales under registration number 13778365. 
Our registered office is at St James' Hall, Mill Road, North Lancing, BN15 0PT. 

Web: www.emvexis.com 

Manuals, software downloads, technical information etc: www.emvexis.com/adr  

Phone: +44 (0) 1273 80 7754 

  

http://www.emvexis.com/
http://www.emvexis.com/adr
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2 Introduction 

The Emvexis ADR1 is a high-performance, robust and cost-effective Accident Data 
Recorder system designed primarily for motorsport applications and is homologated in 
accordance with the FIA 8872-2018 Accident Data Recorder standard, under 
homologation number ADR.003.24. 

The FIA technical lists, which detail homologated manufacturers and their products, are 
published at https://www.fia.com/regulation/category/761 

The ADR is suitable for use in motorsport applications which mandate FIA 8872-2018 
ADRs, in series where their use is not mandated, and even in series not controlled by the 
FIA. In the latter case, specific functionality modifications and software features may be 
supported by Emvexis upon request. 

The ADR is also particularly suited for a variety of other applications: 

• non-track motorsport applications such as powerboat racing 
• law enforcement and coastguard marine applications 
• high-performance automotive applications. 

The system is comprised of 2 parts: 

• The ADR hardware 
• Emvexis ADR Utility software application 

The ADR hardware internally performs high speed sensing, acquisition, real-time signal 
processing and event-triggered logging of tri-axis acceleration and gyroscopic rate data, in 
addition to capturing additional parameters from the vehicle via CAN. 

It is designed and tested to operate in all weather conditions, with a BS EN 60529 IP66/IP67 
rating, protected from dust ingress, powerful water jets and the effects of temporary water 
immersion, across a wide temperature and operating voltage range. 

All electrical I/O is protected against typical automotive transient and EOS conditions, 
allowing it to operate in electrically harsh environments without additional external 
protection. 

  

https://www.fia.com/regulation/category/761
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2.1 Definitions, Acronyms and Abbreviations 

The following acronyms and abbreviations are used extensively throughout this document 
and are detailed below for brevity. 

Acronym Expansion 
ADR Accident Data Recorder 
ASI Accident Severity Index 
ASN Autorité Sportive Nationale 
CAN Controller Area Network 

CAN-FD CAN Flexible Data-Rate 
DFU Device Firmware Update 
EOS Electrical Overstress 
ESD Electrostatic Discharge 
FIA Fédération Internationale de l'Automobile 
GUI Graphical User Interface 
LED Light Emitting Diode 
LSB Least Significant Bit 
mA milliamps 
ms milliseconds 

MWL Medical Warning Light 
RTC Real Time Clock 
UI User Interface 

USB Universal Serial Bus 
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3 Device Overview 

3.1 Product Features 

• Internal 3-axis high range accelerometer 
• Internal 3-axis low range, high resolution accelerometer 

o Synchronization between low and high range guaranteed 
• Internal 3-axis high resolution gyroscope 

o Synchronization between gyroscope and accelerometers guaranteed 
• Data channels compliant with ISO 6487, CFC60 
• Internal backup power supply to allow continued operation after loss of power 

supply 
o Software configurable charging current limit 

• Wide operating voltage front end, including cold crank operation 
• Internal storage for up to 25 events worth of data 
• Onboard status LED 
• 2x constant current LED drivers for external indicator LEDs 
• Internal pressure sensor for case seal integrity verification 
• Deutsch Autosport / Souriau 8STA electrical connector 
• Internal low-drift real time clock with battery backup for time and date stamping of 

events 
• CAN 2.0B for capturing vehicle parameters such as steering angle and brake 

pressures 
o Hardware is CAN-FD capable 
o Software selectable 120Ω bus termination resistance 
o Software selectable 4.7nF termination split filter capacitor 
o Extensive CAN physical fault tolerance 

• USB 2.0 for communication with ADR Utility PC Software 
• RS232 hardware for communication with legacy devices 

 

3.2 Product Specifications 

 Internal Sensor Specifications 

Table 1 - Inertial Sensor Specifications 

Sensor Parameter Typical Units 

High range accelerometer 

Range ±200 
g 

Resolution 0.1 
Non-linearity ±0.5 

% 
Cross-axis sensitivity ±2.5 
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Sampling rate 3000 
Hz 

Logging rate 1000 

Low range, high resolution 
accelerometer 

Range ±16 
g 

Resolution 0.000488 
Non-linearity ±0.05 

% 
Cross-axis sensitivity ±1 
Sampling rate 

1000 Hz 
Logging rate 

Gyroscope 

Gyroscope range ±2000 
°/sec 

Gyroscope resolution 0.060975 
Non-linearity ±0.1 

% 
Cross-axis sensitivity ±1 
Sampling rate 

1000 Hz 
Logging rate 

All 

Time synchronisation between high and low range 
accelerometers, and gyroscope 

±1 ms 

Time from power on to ADR functional, including 
automatic zeroing complete 

8 note 1 sec 
13 note 2 sec 

 

1. USB not connected to PC 
2. USB connected to PC, ADR waits 5 seconds listening for a firmware recovery command before booting main application firmware 

 

 Electrical Specifications 

The device must be operated within the ratings listed in the table below in order for all 
homologated performance characteristics to be valid. 

Table 2 – General System Specifications 

Parameter Min Typical Max Units 
Supply voltage 6 - 40 VDC 
Operating 
temperature range 

-40 - 85 °C 

Backup Power 
Supply duration 

- 5 - minutes 

Constant current 
LED driver current 

- 19 - mA 

 

 Current Consumption 

The ADR is optimised for low power consumption, and whilst its current consumption is 
heavily dependent upon configuration options, under normal conditions its current 
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consumption is extremely low. The baseline current consumption, and factors affecting 
current consumption are listed in the table below. 

Values listed as +, are additive to the baseline consumption.  

Table 3 - Current Consumption 

Parameter Conditions1 Typical Units 

Current 
consumption 

Baseline: CAN bus and termination disabled, no 
external LEDs connected, backup supply charged, 
no faults present 

14 

mA 

CAN bus termination enabled +2 
CAN bus termination split filter enabled +2 
External status LED enabled and illuminated +6 
External Medical Warning Light LED enabled and 
illuminated 

+6 

CAN bus active, with bus activity limited to the CAN 
messages defined in FIA standard messaging 
protocol 

+2 

Backup power supply charging at maximum 
configured rate 

+196 

 
1. All currents given at 13.8VDC supply voltage 

 

3.3 Mechanical and Environmental 

• Electrical connector: see Electrical Connector Pinout 
• Construction: machined billet aluminium case, blasted and anodised 
• Ingress Protection Rating: BS EN 60529 IP66 / IP67 
• Weight: 260 grams 
• Physical dimensions: 
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4 ADR Utility PC Software 

The ADR is supported by our free-of-charge Windows® PC software application, ADR 
Utility, which may be downloaded from here. The software is used to configure and interact 
with an ADR, and to download and view event files. 

Throughout this User Manual, usage of ADR Utility is demonstrated as and when each 
functionality of the ADR is described, such that both ADR and ADR Utility functionality are 
introduced together. 

4.1 System Requirements 

• Operating system 
o Windows® 10 (Home, Professional, IoT Enterprise) 64-bit 

 Version 10.0.17763.0 or higher 
o Windows® 11 (Home, Professional, IoT Enterprise) 64-bit 

• Hardware Requirements 
o Processor: 1GHz minimum 
o Memory (RAM): 4GB minimum 
o Storage: 1GB free space 

• Display: 
o Minimum 1024x768 pixels 

• Additional: 
o Dedicated GPU not required 
o Installation is not required, application is portable 
o Internet connection is preferable, but not required 

4.2 Installation 

ADR Utility does not require installation on a PC, the application is a single standalone 
Windows® executable, and is launched by a double-click on the file, as per any other file 
or shortcut. 

It is even possible to run the application directly on a USB stick, although it is strongly 
recommended to copy the application locally to your PC – this is because removing the 
USB stick will close the application unexpectedly. 

 

4.3 Features 

ADR Utility includes features to enable use of all of the ADR’s capabilities, in addition to 
productivity enhancing features. The software includes: 

https://www.emvexis.com/redirect/VKMzGv
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• A graphical, interactive data visualization user interface, allowing ADR event data to 
be plotted, zoomed, isolated etc 

• Ability to view, download and delete stored event files 
• ADR configurator, to configure both user settings and FIA restricted settings 
• ADR health information, displaying extensive diagnostic and fault information 
• Numerous tools such as the ability to manually trigger an event, explicit sensor 

zeroing etc 

 

4.4 Getting Started 

ADR Utility is a simple graphical user interface that will immediately feel familiar to any PC 
user with experience using traditional Windows® desktop applications. 

On first launch of the software, an onboarding screen is displayed. To use the software 
you must read and accept the privacy policy. 

Figure 1 - ADR Utility Onboarding Screen 

 

After proceeding past the onboarding screen, the main software UI is displayed. The three 
highlighted regions of the UI, remain constant at all times in the UI: 

• Blue – main tool strip, includes typical application functionality such as application 
settings and help menu, and multiple ADR tools 

• Green – application tabs, opening different environments used for purposes such 
as viewing events, downloading events and configuring the ADR 
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• Red – lists current ADR connection status, serial number etc, and includes controls 
for connecting to an ADR 

 

Figure 2 - ADR Utility Main UI 

 

4.5 Connecting to an ADR 

To connect to an ADR requires only a few steps 

1. Connect the PC to the ADR using an ADR Interface Cable 
2. Open the ‘Connection Controls’ menu in the lower left corner 
3. Select an ADR from the drop-down list. The list contains only Emvexis ADR1 

devices, and excludes all other connected USB devices 
4. Click ‘Connect’, and ADR Utility will connect with the ADR, and display the serial 

number of the connected ADR in the status strip 
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Figure 3 - Connecting to an ADR 

 
Figure 4 - Connection Made 

 

 

Further details about the connected ADR may be viewed under Connection Controls > 
Show ADR Properties. 

 

4.6 Restricted Functions 

Numerous functions performed using ADR Utility, are required by the FIA 8872-2018 
standard to be passcode protected, such that these functions are restricted to the FIA, or 
an authorised delegate such as an ASN or championship organiser.  
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An attempt to perform these functions without unlocking the ADR, simply results in a 
rejection notification. 

 

 Access Control Levels 

The functionality is protected by 2 different lock levels; a ‘level 1’, and ‘level 2’ lock. 

The level 1 lock protects functions only permitted to be changed by the FIA, whilst the level 
2 lock protects functions authorised to be changed by delegates. Each lock has a separate 
passcode. 

 

Table 4 - Protected Functions by Lock Level 

Function 
Protected By 

Level 1 Lock Level 2 Lock 
Deleting events ✓ ✓ 

Factory reset ✓  
Resetting the External Medical Warning Light ✓  

Re-zeroing the internal sensor channels ✓  
Changing restricted configuration 

parameters (orientation and triggers) ✓  

 

The ADR is locked, and unlocked using the menu commands shown above, which raises a 
window to enter the passcode. 

 



DC-3147-A 
User Manual – ADR1 

 
 
 
 
 

 Circulation: Public 
 16 of 63 

4.7 Configuration 

Configuration of the ADR is performed using ADR Utility. The configuration may be edited 
‘live’, by changing parameters and settings on the connected ADR directly, or, 
configurations may be loaded from a configuration file. 

The latter is useful where multiple ADRs need configuring with the same settings 

 

4.8 Manual Event Triggering 

Events may be triggered manually for the purposes of demonstration and test. A manually 
triggered event is the same as a triggered event in all respects as described in the Events 
and Event Files section, with the sole exception that a manually triggered event is marked 
as such, this is because a manually triggered event can be triggered with no impact 
acceleration data high enough to trigger an event present, and thus it is important to show 
why this event exists. 

To manually trigger an event: 

1. Connect to the ADR in question 
2. Click ADR Tools > Test Functions > Trigger Manual Event. In some cases the request 

will be rejected (if for example, an event erase is in progress). Either way, ADR Utility 
will inform if the command was accepted or rejected. When the event completes, 
a second notification will be displayed. 
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3. The event may be viewed in, and downloaded from, the event download list and 
will be shown with a tick in the ‘Is Manual Event’ box to display that this event was 
manually triggered  

 
 

4.9 Sensor Zeroing 

In normal operation there is no need to zero the ADRs internal accelerometers and 
gyroscopes, as this is performed automatically on power up of the ADR. 

However there may be some cases where this is necessary, for example: 

• The ADR was powered on whilst removed from a vehicle, at an arbitrary inclination 
• The vehicle itself was in a severely inclined position whilst the ADR was powered 

on 

If such a scenario has occurred, the ADR will still fundamentally function, though the 
following should be noted: 

• The zero offsets of each channel will be incorrect, for example if a vehicle was on a 
45° incline in X or Y, when the ADR is powered on, when the vehicle returns to 
horizontal, the Z axis will report 1.293g at 1g, due to sensing a real 1g, plus the 
vector component of 1g at 45 degrees  

• Trigger thresholds may be affected, for example if an ADR was powered on, on its 
side, the Z axis will sense 2g when the ADR is righted. This means impacts will falsely 
read 1g higher, thus reaching trigger thresholds earlier 

Zeroing the sensors is a restricted function, per the requirements of the FIA 8872-2018 
regulation. To zero the sensors: 

1. Connect to the ADR in question 
2. Click Restricted ADR Tools > Zero Sensor Channels. In some cases the request will 

be rejected (if for example, an event is in progress). Either way, ADR Utility will 
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inform if the command was accepted or rejected. When the process completes, a 
notification will be displayed. 

 

 

4.10 Updating ADR Firmware 

The ADR firmware is easily updated if necessary, by ADR Utility. Firmware files are 
encrypted binary files, named using the following typical format: 

adr-application-fw-6dde15d2afc25e32c0de5fd0088b26d34ec7ba99-clean 

Firmware updates are made available through the Emvexis website and may be accessed 
from the following location in ADR Utility. 

 

Figure 5 - Firmware Update Web Link 

 

To perform a firmware update: 

1. Connect to the ADR to update 
2. Open ADR Tools > Firmware Flash 
3. In the window that opens, click Actions > Enter DFU Mode 
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4. The ADR will reboot, and the onboard status indicator LED will show a solid orange 
status. Information on the DFU progress so far, is displayed 

 

5. Click File > Open Firmware Image. Navigate to the firmware file using the standard 
file dialog window that opens. 



DC-3147-A 
User Manual – ADR1 

 
 
 
 
 

 Circulation: Public 
 20 of 63 

 

6. Click Actions > Flash Firmware Image. Read and understand the warning notice that 
is displayed, and click OK 

 

7. The process takes only a few seconds to complete, and when complete the ADR 
will reboot into the new firmware. Click OK to return  ADR Utility to normal 
operation 
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5 Modes of Operation 

The ADR may operate in one of two modes: 

1. Standalone, connected only to the vehicle’s power supply 
2. Networked, connected to the vehicle’s CAN network, for the purpose of capturing 

additional vehicle parameters (steering angle, brake pressures etc) used to 
supplement the event data captured by the ADR 
 

5.1 Standalone Operation 

In this mode, the ADR uses its internal accelerometers and gyroscopes to measure and 
log acceleration and gyroscopic rate data. If an event is triggered in this mode, the event 
files contain two sets of 3 axis acceleration data (high range XYZ, and high resolution XYZ), 
in addition to 3 axes of gyroscopic rate data (XYZ). 

All other event channels normally used in networked operation, will read as zero. 

Therefore whilst standalone operation still captures the fundamental inertial data, the 
datasets lack the additional channels that are present when the ADR is networked, which 
are extremely useful in any crash analysis 

 

5.2 Networked Operation 

In this mode, the ADR functions fundamentally the same as in standalone operation, 
except for that an additional 12 data channels are captured from the vehicles CAN bus. 
These channels are defined in Channels. 

Further to the 14 additional data channels, 2 additional event properties are captured via 
CAN: 

• Lap number at the point of the event trigger 
• GPS time 

Wherever possible it is highly recommended that the ADR be used in this mode. 
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6 Events and Event Files 

The ADR operates on the principle of continuously holding the last 45 seconds of data 
from all channels in memory. Each time a new sample is captured, the oldest sample is 
overwritten. 

This temporarily held data is not stored in permanent memory. 

For the ADR to permanently store data, it must be triggered. A trigger is what causes an 
event to be captured. 

Triggers are acceleration thresholds, combined with time counters, that when exceeded -
trigger an event. Triggers are discussed in more detail in 6.5. 

In the following sections events and triggers are discussed in detail, including an overview 
of how to download, and view events is given. 

 

6.1 Downloading Events from an ADR 

ADR Utility displays a list of all events currently saved in the ADR, to view the event list: 

1. Connect the PC to the ADR using an ADR Interface Cable 
2. Open the Event Download tab in the main user interface 
3. Click ‘Refresh Event List’ 

The list of all events stored in the ADR will be displayed, including timestamps, ASI, whether 
the event has been downloaded before, by anybody, and whether it was a manually 
triggered event. 
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To download an event: 

1. Highlight the event row to download 
2. Click Download > Download Selected 
3. Select where you wish to save the event in the dialog that is displayed 

When the event download starts, a progress bar is shown, and the download can be 
cancelled at any time. Each download takes approximately 8.5 seconds. 

 

Events may be deleted from the ADR using Delete > Delete Selected, or Delete All. Note 
however this is a restricted function. 

 

6.2 Opening and Viewing Event Files 

ADR Utility includes a graphical event viewer, under the ‘Event Viewer’ tab. 
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Event files downloaded from the ADR are opened into the Event Viewer from an event file 
saved on the PC. To open an event file: 

1. Click File > Load Event > From File. 
2. Navigate to the file using the dialog that is displayed 

 

Selecting ‘From ADR’ instead of ‘From File’ moves to the Event Download tab, to allow you 
to first download events. 

6.3 Event Structure 

All events are 30 seconds in duration, and in normal cases the event captures 15 seconds 
of data prior to the trigger, and 15 seconds after the trigger. The image below 
demonstrates this; the ~40g impact in the middle of the display plot, is at 15 seconds, thus 
the event contains both pre and post trigger data. 

Figure 6 - Event Trigger Location 
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Note however, that there are exceptions to this, described in Special Conditions. 

6.4 Channels and Properties 

During an event the ADR captures numerous data channels, which are continuously 
sampled and logged throughout the event, i.e. these data channels contain time history 
data. 

In addition to the data channels, additional event metadata is captured. This metadata is 
comprised of parameters which do not change over the duration of the event, but rather 
are a snapshot in time at the point of event triggering. This metadata includes: 

• Event properties, a collection of parameters related to the event itself, such as 
timestamps, ADR serial number, firmware version etc 

• Event faults, a record of any fault codes set during the event 
• Channel properties, parameters such as units, min/max values, and per-channel 

error checking CRC-32 fields 
• ADR configuration, a full copy of the ADRs configuration as it was at the time of the 

event 

Each of these channels and properties are described below. 

 

 Channels 

The ADR logs either 12, or 26 channels depending on whether it is used in standalone or 
networked mode, as per the table below. 

Table 5  - Event Channel Descriptors 

Channel Name Channel Description Source 
Logging 
Rate, Hz 

Units 

gADRX 
High range acceleration, anti-aliased, no 

further filtering, vehicle XYZ 

ADR 
internal 

1000 

g 

gADRY 
gADRZ 

gCFC60X High range acceleration, anti-aliased & 
digitally filtered to ISO 6487 CFC60, vehicle 

XYZ 
gCFC60Y 
gCFC60Z 

g_lo_CFC60X Low range, high resolution acceleration, anti-
aliased & digitally filtered to ISO 6487 CFC60, 

vehicle XYZ 
g_lo_CFC60Y 
g_lo_CFC60Z 

nADRX 
High range gyroscopic rate, anti-aliased, no 

further filtering, XYZ 
°/sec nADRY 

nADRZ 
brake_pres_f Brake hydraulic pressure 100 bar 
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brake_pres_f 

Vehicle 
systems 
via CAN 

lap_distance Distance travelled on current lap meters 
lap_number Current lap number n 

engine_speed Engine rotational speed rpm 
v_car_wheel Vehicle speed calculated from wheel speed kph 

throttle_pedal Throttle pedal demand % 
steer_angle Steering angle ° 

throttle_actuator Throttle actuator demand % 
gps_speed Ground speed as measured by GPS 

10 

kph 
gps_altitude Altitude as measured by GPS meters 

gps_lat Latitude as measured by GPS 
1e7° 

gps_long Longitude as measured by GPS 

gps_status Connected (via RS-232) GPS module status 
Module 
specific 

 

 Event Properties 

Each event file contains a set of Event Properties, viewable under the Event Properties tab 
in Event Viewer. 

Figure 7 - ADR Utility Event Properties 
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These parameters relate to both the ADR itself (for example, serial number that captured 
the event), and to the event (for example, date and time stamp). 

Each of the parameters included in Event Properties are described in the table below. 

Table 6 - Event Property Parameter Descriptions 

Property Type Description 
Filename Text Filename of the event .XML file 

Manually Triggered Event Yes/no 
Determines whether this event triggered manually 
using the Trigger Manual Event function in ADR Utility, or 
was it a real event 

ADR Internal Event ID Value 
ID assigned to the event by the ADR, this ID combined 
with the ADR serial number uniquely identifies an 
Emvexis ADR event file 

Date & Time Datetime 
Date and time stamp of the first sample within the 
dataset 

Accident Severity Index Value, g 
Maximum absolute acceleration recorded at any time 
point within this event, in any axis 

ADR Firmware Version Version, X.Y 
Version of the ADR application firmware in use at the 
time this event was captured 

ADR Serial Number Value 
Unique hardware serial number of the ADR that 
captured this event 

ADR Bootloader Version Version, X.Y 
Version of the ADR bootloader firmware in use at the 
time this event was captured 

ADR Firmware Hash SHA-1 hash 
Cryptographic hash used to uniquely identify the ADR 
application firmware build with absolute certainly 

ADR Firmware Build 
Status 

- Internal use only 

ADR Bootloader Hash SHA-1 hash 
Cryptographic hash used to uniquely identify the ADR 
bootloader firmware build with absolute certainly 

ASH Bootloader Build 
Status 

- Internal use only 

Lap Number Value Current lap number when the event was triggered 
Lap Distance Value, meters Current lap distance when the event was triggered 

ADR Internal Pressure Value, mBar 
Pressure of the ADR internal air volume when the event 
was triggered 

ADR Internal 
Temperature 

Value, °C 
Temperature of the ADR internal components when the 
event was triggered 

Event Format Value 
Reserved for future use; identifies format of the event 
file to allow newer format versions of event files to be 
recognised by ADR Utility, to support new features 

Number of Channels Value Number of Channels included within this event 
Event Length Value, seconds Number of seconds of data within this event 



DC-3147-A 
User Manual – ADR1 

 
 
 
 
 

 Circulation: Public 
 29 of 63 

 Event Channel Properties 

Event files contain properties specific to each data channel, as shown below. As each 
channel is selected in the Available Event Data Channels list (bottom left), the Channel 
Properties (top right) view will update to show the properties, for the selected channel. 

Figure 8 - ADR Utility Event Channel Properties 

 
 

Each of the channel properties, and their associated meanings are described in the table 
below. 

 

Table 7 - Event Channel Property Descriptors 

Property Description 
Channel Name Name of the currently selected channel, from the list of Channels 
Units Units of the parameter in this channel, for example g, °/sec 
Sample Rate Number of samples per second, in this channel 
Min Value Minimum numerical value in this channel, in this event 
Max Value Maximum numerical value in this channel, in this event 

Data CRC-32 
Error-detecting code, calculated by the ADR for this channel only, when the 
event was stored. Used by ADR Utility to compare against when recalculating 
this channels CRC-32, to determine whether data corruption has occurred 
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Data Intact 
See above, if a freshly calculated CRC-32 of this channel matches the saved 
CRC-32, the data has not been corrupted 

CAN Data in Sync 
For channels obtained via CAN, if any CAN faults occurred during capture of 
this event, this property warns for this 

 Event Configuration 

Within each event file is a copy of the ADRs configuration that was in use at the time when 
the event was captured. 

A good example of why this configuration data is included is, for example; even if it is 
known with certainty which orientation an ADR was installed in a vehicle at the time of a 
given event, if it is not known which orientation setting was configured, then it is impossible 
to know with certainty if the X,Y and Z channels are correctly mapped to the vehicle 
coordinate system. 

 

6.5 Triggers 

As described above, a trigger is what causes an event to be captured. There are 
independent triggers for each axis, and each axis direction has an independent trigger. 

In addition, there is a secondary set of triggers used to independently trigger the External 
Medical Warning Light, allowing the MWL and events to be triggered at separate 
acceleration and time thresholds. 

The image below shows a screenshot from the ADR Utility PC Software, where the triggers 
may be configured. 
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Figure 9 - ADR Utility Trigger Configuration 

 

Each trigger is comprised of 2 parameters: acceleration, and time. For a trigger to be 
triggered, the measured acceleration in that axis must exceed the configured acceleration 
threshold, for more than the time specified. 

The acceleration must be consecutive, for example if there are 4ms of 18g but the next 
millisecond is 14g, the time counter is restarted and the acceleration would need to be 
measured above 15g for another full 5ms. 

Finally, the acceleration is treated as an absolute value, whilst considering the thresholds 
as signed. For example, 4ms of 18g, followed by 2ms of -18g will still trigger, as the absolute 
acceleration was above both the positive, and negative triggers, for more than the trigger 
duration. 

Once an event is triggered, event detection is disabled until it is reenabled towards the 
end of the current event as described in Special Conditions. This is to prevent multiple 
events being triggered due to multiple closely space impacts, in for example a vehicle 
rollover condition. 
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 Special Conditions 

As described above, events are always 30 seconds, and typically contain 15 seconds of 
pre-trigger data, and 15 seconds of post-trigger data. 

The 15 second pre/post-split is not always true however, when: 

1. An event is triggered less than 15 seconds after the ADR is powered on and starts 
sampling, the event will still be 30 seconds long, but the trigger will not be at 15 
seconds. For example if there is only 5 seconds of data available, the event will 
contain 5 seconds of pre-trigger data, and 25 seconds of post-trigger data, per the 
below image. 

Figure 10 - Early Event Trigger 

 

2. Once an event is triggered, further event triggering is disabled until 10 seconds 
before the end of the current event. That is, triggering is re-enabled at 20 seconds 
into the current 30 second event. 
 
If an impact triggers an event after the trigger re-enable point, a back-to-back event 
is triggered, meaning that once the current event ends, a second event follows on 
immediately. In practice, this means the trigger point is not within the second event, 
and thus the entire second (or third, fourth etc) event is purely post-trigger data. 
Therefore in the below image, the second acceleration pulse will not trigger a back-
to-back event, because it occurs before the trigger re-enable point. 



DC-3147-A 
User Manual – ADR1 

 
 
 
 
 

 Circulation: Public 
 33 of 63 

Figure 11 – Disabled Triggers 

 

 
In the below image, the second impact pulse will trigger a back-to-back event, because it 
occurs after the trigger re-enable point. 

Figure 12 – Back-to-back Event Trigger 

 

 

 Exporting Events to CSV 

In some cases it may be desirable to export an event file to CSV, for use in other software. 
ADR Utility supports exporting to CSV, with the channel order defined by FIA 8872-2018. 
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Unless absolutely necessary, Emvexis advises against exporting to CSV, as much of the 
accompanying event metadata is lost, such as: 

• Event properties 
• Event fault information 
• ADR configuration information 

CSV file sizes are notably larger than the XML file from which they were created. The 
filename, channel order, and CSV headers included in the file are all defined by FIA 8872-
2018 and are not configurable. 

To perform an export: 

1. Open the event .XML file in ADR utility that you wish to export to CSV 
2. Click File > Export Event > To CSV 
3. Choose the location to save the file to, in the dialog that is displayed 
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7 Electrical Connector Pinout 

The ADR follows the pinout convention required by FIA 8872-2018, and uses either of the 
following connectors: 

• Souriau 8STA2-1035PN, mates with 8STA6-1035SN, or 
• Deutsch AS210-35PN, mates with AS610-35SN 

Note that both connector options are interchangeable, and ADRs may be shipped with 
either Souriau or Deutsch connectors. 

The pin physical positioning follows the diagram below, relative to the single master 
keyway slot in the connector shell. The diagram below is looking into the male-pinned ADR 
connector, not the female-socket cable plug. 

 

The pinout functional mapping corresponds to the table below. 

Table 8 - Connector Pinout 

Pin Number Pin Function Notes 
1 RS-232 RX  
2 External Medical Warning Light See External Medical Warning Light 
3 CANH  
4 CANL  
5 External Status Light See External Status Light 
6 RS-232 TX  

7 USB VBUS 
+5VDC USB supply. Only used when 

connected via USB 
8 USB D+  
9 USB D-  

10, 11 Not used Reserved for future use 
12 Battery positive  
13 0V  

 

Emvexis supplies USB only ADR Interface Cables using this connector and pinout 
specification, for USB connection to the ADRs. 
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8 Status Indicator LEDs 

The ADR provides three methods of visually indicating status information: 

1. an on-board multi-colour LED, 
2. the ability to drive two external LEDs via its constant-current driver output pins (see 

Electrical Connector Pinout) 
3. broadcast of status information via CAN, which may be received by a third-party 

device to either drive LEDs or display information on a screen 

8.1 On-board LED 

The ADRs on-board, multi-colour LED function is defined primarily by the FIA 8872-2018 
standard and is thus fixed/not user configurable. Additional colour/flash states beyond 
those specified in FIA 8872-2018 are used and are not configurable. 

The LED can display red, green and orange, and these colours combined with various flash 
states, are used to indicate the status of the ADR, as defined in the table below. 

Table 9 - Onboard LED States 

ADR State Colour 
Flash Frequency, 

Hz 
Duty Cycle 

Brightness, 
% 

Normal, no faults Green 0 

 
100% 

50 
Busy1 Orange 0 

Hard fault present Red 0 

Normal, soft fault 
present 

Green 1 

 
50% 

100 

Triggered Green 10 
Booting Orange 10 
Self test Orange 2 

Event Stored Red 4 

 
5% 

Low power sleep Orange 1 

 
1% 

 
1. Busy states include event download, event erase, firmware update in progress 
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8.2 External LEDs 

The ADR can drive 2 external LEDs, via pins 2 and 5. These pins are constant current LED 
drivers, and thus require no external current limiting resistor. The drivers output a 
constant 19mA current, regardless of the connected LEDs forward voltage. It is therefore 
recommended to select external LEDs rated for a forward current of at least 25mA. 

The equivalent control circuit for the external LEDs, is shown below, and is duplicated for 
both the External Status Light, and the External Medical Warning Light. 

Note ESD protection input structures are present, but not shown in the diagram. 

The status of the external LED is linked to the On-board LED states, as shown in the table 
below. 

Table 10 - External LED States 

ADR State Ext Status LED2 

Normal, no faults On 
Busy1 Off 

Hard fault present Off 
Normal, soft fault present On 

Triggered On 
Booting Off 
Self test Off 

Event Stored On 
Low power sleep Off 

 
1. Busy states include event download, event erase, firmware update in progress 
2. External status LED disabled in low power mode 

Figure 13 - LED Driver Equivalent Circuit 
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 External Status Light 

The external status light is a simplified duplication of the on-board status LED. It has only 
2 states, on or off. Table 9 - Onboard LED States details when the external status LED is 
illuminated, or not. 

The external status light may be enabled, or disabled via the ADRs configuration, using the 
ADR Utility software. 

 

 External Medical Warning Light 

The external Medical Warning Light (MWL) is a configurable indicator light used to inform 
trackside staff attending an incident (for example, medical crews), that an impact of a 
certain severity has occurred, which is used to trigger appropriate medical procedures for 
example. 

The MWL is triggered in the same way events are triggered, but must be configured equal 
to, or greater than the threshold used for event triggers, and any attempt to configure 
otherwise will be rejected by ADR Utility. This is to guarantee that any impact that triggers 
the MWL, will also trigger an event. 

The MWL may be enabled, or disabled via the ADRs configuration, using the ADR Utility 
software. Once triggered, the MWL is cleared by 1 of 3 different mechanisms: 

1. A power cycle of the ADR (including full discharge of the internal backup supply) 
2. Erasing all events currently stored in the ADR 
3. Manually resetting the MWL via ADR Utility 

Note that for options 2 and 3 above, these are passcode protected functions that require 
either the FIA or authorised delegate to perform these. 

To reset the MWL, first unlock the ADR, and then click Restricted ADR Tools > Reset Medical 
Warning Light (MWL) 

 

Alternatively, erasing all events from the ADR will also reset the MWL. 
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8.3 Special case – low power mode 

In the case of external power supply to the ADR having been lost, the ADR automatically 
switches to using its own internal backup power supply, which allows the ADR to continue 
operating normally for approximately 5 minutes. 

During backup operation, to extend the period the ADR is able to operate from its backup 
supply, the LED behaviour is altered, specifically: 

• The external status LED is disabled 
• In the ‘Normal, no faults’ ADR state, the LED brightness is reduced from 50%, to 

25% 

 

9 Configuration 

The ADR is configurable by the user to suit the application in which it is being used. Some 
of the configurable parameters must be configured by the vehicle manufacturer, or 
installer of the ADR, whilst other parameters may only be configured by the FIA, or 
authorised delegate, as per requirements of a given championship, such as event 
triggering thresholds. 

All configurable parameters are grouped into two categories: 

1. User Parameters – these are parameters that any user can configure at any time 
2. Restricted Parameters – these are parameters that only the FIA, or its authorised 

delegates may configure, and are passcode protected 

 

9.1 Loading Configuration from ADR 

To edit the configuration in an ADR: 

1. Connect the PC to the ADR using an ADR Interface Cable 
2. Open the ADR Configuration tab in the main user interface 
3. Click Actions > Load Configuration > From ADR 
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Figure 14 - Opening an ADRs Configuration 

 

9.2 Loading Configuration from files 

Instead of loading a configuration directly from an ADRs memory, it is possible to load a 
configuration from a file stored on the PC. 

This is useful where the same configuration needs to be applied to multiple ADRs quickly; 
whilst the ADR stores its configuration file in internal memory, if the same configuration is 
to be used for multiple ADRs, the configuration may be opened from file, and then saved 
into each ADR. 

The configuration files are saved as human readable .XML files. 

 

Figure 15 - Opening an ADR Configuration File 
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9.3 Saving Configuration to ADR 

Once changes are made to a configuration that has been loaded from an ADR, or from a 
file, the configuration needs to be saved back into the connected ADR, using Actions > 
Save Configuration > To ADR. 

It is possible that the ADR may reject the configuration, if invalid configuration settings are 
applied, such as setting the MWL thresholds lower than the event thresholds. Whether 
the configuration is accepted or rejected, ADR Utility will notify you. 

If the configuration update is successful, the ADR performs a soft reboot whereby all of 
the configuration settings are applied as if the ADR is powering up from cold, which 
includes performing a sensor zeroing, as the orientation settings may have been changed. 

Figure 16 - Saving a Configuration to ADR 

 
Figure 17 - Successful Configuration Update Notifications 
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10 Fault Handling 

The ADR incorporates an extensive fault management system, which at the time of 
homologation monitors more than 80 possible fault conditions. The fault management 
system is designed to achieve several key objectives: 

1. Prevent physical damage to the ADR – some conditions require software 
interaction from the ADR, for example latching off CAN bus termination resistors 
under persistent thermal overload conditions due to damaged CAN bus wiring 

2. Maximise availability of the ADR system – if subsystems or specific functions of the 
ADR become faulty, but the ADR is able to continue functioning with a degradation 
in performance, or loss of a particular function, the fault management system 
enables this 

3. Maximise fault information to the user – allows an informed decision to be made 
as to the validity of captured event data. For example, if an ADR is heated above 
the maximum operating temperature, the accuracy of the internal sensors is 
degraded 

 

10.1 Hard vs Soft Faults 

Faults are categorised into 1 of the 2 following severity categories: 

1. Hard faults – these are high severity faults, which the ADR cannot recover from and 
results in a total loss of ADR function. The number of possible hard fault conditions 
is limited. 

2. Soft faults – these are low severity faults, which if present do not fundamentally 
prevent the ADR performing its function but may impact quality or correctness of 
data captured. For example, a fault with the backup power supply system may 
impact the ADRs ability to power itself should the main vehicle supply is lost, but 
so long as this external supply remains present the ADR is able to continue 
performing all of its functions 

 

10.2 Inclusion in Events 

Every event captured by the ADR includes within its event file a list of any faults that were 
set at any point during the event. This allows an informed assessment to be made as to 
the impact any faults may have on the validity of event data. 
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For example, a fault set due to intermittent reception of steering angle data via CAN, as 
opposed to a steady stream of data, informs the user that the events steering angle data 
is unreliable. 

10.3 Viewing in ADR Utility 

There are 2 different contexts in which ADR faults may be viewed in ADR Utility: 

1. As a record of faults captured as part of an event  
2. As a list of faults currently set within an ADR currently connected to ADR Utility, 

including historic fault information, via the ADR Health tab.  

Both current, and historic faults are displayed viewed, including a count of the number of 
times a given fault code has been set. 

Fault set counts may only be cleared (under the Actions menu) by the user for CAN related 
faults, as these faults are set due to external factors (such as damaged bus wiring), 
whereas all other faults relate to internal functions of the ADR. 

In the image below, ADR Utility shows the current fault information for an ADR configured 
to communicate via CAN, but is receiving FIA message 2 at an incorrect frequency, thus 
raising a CAN_MSG_2_PERIOD_ERR fault. 

A description of what each fault code means, and its associated implications is displayed 
directly in the fault list. 

 

Figure 18 - ADR Utility Connected ADR Fault Information 
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Faults captured as part of an event, are displayed within Event Viewer under the Event 
Faults tab, per the image below. Capturing of this fault information is extremely important 
when it comes to assessing the validity of captured data. 

For example, if data on one or more of the CAN channels appears to contain nonsensical 
data, but the internal channels appear OK, and the event contains CAN related faults, it is 
possible to determine that there was an issue with CAN communication during the event 
rendering the CAN channels untrustworthy. 

 

Figure 19 - Event Faults 
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11 Diagnostics 

At all times whilst the ADR is powered on, a diagnostic record is maintained, monitoring 
parameters such as temperatures, uptime duration, and number of events captured. 

There are nearly 40 different diagnostic parameters monitored. The diagnostic record is 
viewable in ADR Utility, in the ‘ADR Health’ tab, similar to viewing fault codes. 

The diagnostic record cannot be reset by the user. 

As per the fault code information, a descriptor of each diagnostic parameter is displayed 
in the user interface. 

 

Figure 20 - ADR Utility Connected ADR Diagnostic Information 
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12 Power Supply 

The ADR can be powered via 3 separate voltage sources: 

1. Main vehicle supply 
2. USB 5V supply 
3. Internal backup power supply 

 

12.1 Main Vehicle Supply 

This is the power source most commonly used; supplying the ADR via the Battery Positive 
and 0V pins. This supply is heavily filtered and protected against typical automotive 
transients, including reverse polarity connection. 

When powered from the main supply the internal backup power supply may charge at its 
maximum rate of approximately 3.3W (if configured to do so). 

 

12.2 USB 5V Supply 

To allow a user to connect to the ADR using only an ADR Interface Cable, with no additional 
power source required, the ADR capable of being powered solely by a USB connection. 

The only restriction is that the charging rate of the internal backup power supply is limited 
to approximately 0.4W, however in practice this is no real limitation, as once the ADR is re-
connected to the vehicle harness and power supply, it will resume charging at maximum 
configured power. 

The ADR otherwise behaves exactly as if it were powered by the vehicle supply, allowing 
the user to perform all necessary functions. 

 

12.3 Backup Power Supply 

Under normal operation, the ADR is externally powered via one of the two external 
supplies described above. 

However, in the event of an interruption or loss of the external supply (for example due to 
a severe accident which damages the vehicles electrical system), then to allow the ADR to 
continue performing all its functions, it utilises an internal backup supply. 

The internal backup supply is a supercapacitor backup system, charged when connected 
to an external supply. These supercapacitors supply power into the input of the ADRs 
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various power supplies, such that it can continue normal functioning when operating from 
the backup supply. 

The backup supply charge power is software configurable within ADR Utility. 

The charge current may be configured between 0 and 400mA – note this is current at 5V, 
not at the supply voltage of the ADR. When the ADR is powered with >5V, the current 
drawn by the ADR due to charging will be less than the configured current, approximately 
in accordance with the formula power = voltage x current. 

See Table 3 - Current Consumption for the current drawn at 13.8V supply voltage, for a 
400mA configured charge current. 

 

Figure 21 – ADR Utility Configuring Charge Current 
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13 Real Time Clock 

The ADR features an internal real time clock used to keep track of the current year, month, 
day, weekday, hour, minute and second, for the purposes of timestamping events. 

The RTC automatically handles calendar exceptions such as leap years. 

A dedicated internal backup battery ensures the clock remains continuously powered and 
is sized to last longer than the FIA homologation validity period of the ADR and is thus not 
user serviceable. 

The battery is replaceable by Emvexis if required. 

 

14 Communication 

The ADR features multiple communication interfaces, for the following purposes: 

1. Setup and configuration of the ADR 
2. Capturing of additional data from the vehicle's communication networks 
3. Broadcasting of data from the ADR, onto the vehicle's communication networks 
4. Providing 'expansion' capability to interface with other devices, such as external 

GPS receivers 

 

14.1 USB 

The ADR features a USB 2.0 interface, used for both configuration and event download. 
No special software drivers are necessary, all the necessary drivers are built into 
Windows®. 

 

14.2 CAN 

The ADR hardware supports both classical CAN, and CAN-FD according to ISO 11898-
1:2015, but implements only classical CAN, to comply with the requirements of FIA 8872-
2018. 

The physical interface is designed to be electrically robust, with multiple layers of fault 
protection and tolerance, in addition to extensive application-software level diagnosis to 
detect conditions such as missing messages, or incorrect message reception frequency. 
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Configuration of the ADRs CAN functionality is limited due to the requirements of the FIA 
8872-2018 regulation. For example, the number of, frequency and contents of messages 
are all strictly defined by the regulation, and thus are not configurable. 

CAN may be entirely enabled or disabled on an ADR, to account for the fact that some ADR 
installations will not make use of CAN, and disabling CAN will prevent the ADR raising soft 
faults indicating that CAN communication is not active. 

Configurable settings include: 

• Bus termination options 
• Which incoming, and outgoing messages are enabled 
• Single, configurable out message for external MWL triggering 

 

 Software Selectable Bus Termination 

If bus termination is required at the ADR, no external termination resistors are required. 
The ADR features internal, software selectable 120Ω termination, comprised of two series 
60Ω resistors with software selectable, center tap, split termination filtering. 

The termination resistors are protected from thermal overload during short to VBAT and 
short to 0V conditions, at 24VDC. 

Configuration of the termination is performed using ADR Utility, as per below. The CAN 
must be enabled for the ADR, even if no messages are enabled, for the option to enable 
termination to become available. 
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Figure 22 - CAN Bus Termination Configuration 

 
 

 FIA Standard Messaging Protocol 

The FIA 8872-2018 standard defines a set of messages that must be sent to the ADR by 
the vehicles other systems, including the message IDs and data formats, in addition to the 
messages that the ADR transmits. 

It is permissible for other messages to be present on the bus, the ADR will simply not 
accept those messages. 

All multi-byte fields use big-endian byte order. 

 

Message 1, ID: 0x200, Rate: 100Hz, Direction: Input to ADR 

Byte Description Scaling Type 
0-1 Engine rotational speed 1 rpm/bit 16-bit unsigned 
2 Front brake pressure 

1 bar/bit 8-bit unsigned 
3 Rear brake pressure 
4-5 Lap distance 1 m/bit 16-bit unsigned 
6-7 Throttle actuator position 0.1 %/bit 16-bit signed 
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Message 2, ID: 0x204, Rate: 100Hz, Direction: Input to ADR 

Byte Description Scaling Type 
0-1 Vehicle wheel speed 0.1 kph/bit 16-bit unsigned 
2-3 Steering angle 1 °/bit 

16-bit signed 
4-5 Throttle pedal position 0.1 %/bit 
6-7 Not used - - 

 

Message 3, ID: 0x680, Rate: 10Hz, Direction: Input to ADR 

Byte Description Scaling Type 
0-3 GPS latitude 

1e7 degrees 32-bit fixed point (7dps) value 
4-7 GPS longitude 

 

Message 4, ID: 0x681, Rate: 10Hz, Direction: Input to ADR 

Byte Description Scaling Type 
0-3 GPS time HHMMSSsss1 32-bit unsigned 
4-5 GPS speed 0.1 kph/bit 16-bit unsigned 
6-7 GPS altitude 0.1 m/bit 16-bit signed 

 

1. GPS time encoding example: 23hrs 30mins 40secs 999millisecs, encoded as unsigned numerical integer whose value is 233040999, 
or 0xDE3EC67. Value is transmitted to ADR as: 

a. Byte 0: 0x0D 
b. Byte 1: 0xE3 
c. Byte 2: 0xEC 
d. Byte 3: 0x67 

 

Message 5, ID: 0x682, Rate: 10Hz, Direction: Input to ADR 

Byte Description Scaling Type 
0-2 GPS date DDMMYY1 24-bit unsigned 
3-7 unused - - 

 

1. GPS date encoding example: 18th June 2024, encoded as an unsigned numerical integer whose value is 180624, or 0x2C190. Value 
is transmitted to ADR as: 

a. Byte 0: 0x02 
b. Byte 1: 0xC1 
c. Byte 2: 0x90. 
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Message 6, ID: 0x7B, Rate: 10Hz, Direction: Output from ADR 

Byte Description Scaling Type 

0 Accident Severity Index 
0 = no accident 
1-255 = maximum absolute acceleration 
of last accident detected since power on 

8-bit unsigned 

1 ADR firmware version 10 (e.g. version 3.7 = 37 = 0x25) 
2-3  See table below bitmapped 
4-5 ADR serial number 1 16-bit unsigned 

 

Table 11 - Message 6 Status Bitfield Descriptor 

Bit Description State 

0 Logging in progress 

1 if an event has been triggered, completed, and is 
now currently writing to flash. I.e. this bit only goes 
to 1 for a few seconds after an event has completed, 
else 0. 
 
Bit 4 is more likely to be useful for use by another 
system. 

1 ADR configuration OK 
1 if the ADRs configuration is OK (did not fail CRC-32 
integrity check) and is in use, else 0 and the ADR is 
using factory default configuration settings. 

2 CAN communication OK 
1 if CAN is enabled, and no CAN Protocol Faults are 
set, else 0 

3 Accident stored 1 if ADR contains at least one stored event, else 0 

4 Accident active 
1 if an event is currently triggered, and in progress, 
else 0 

5 Download mode 
1 if USB interface is connected to ADR Utility (not 
just plugged into PC), else 0  

6-15 Unused Always 0 
 

 

Message 7, ID: 0x81, Rate: 10Hz, Direction: Output from ADR 

Byte Description Scaling(2,3) Type 

0-1 
Gyroscope yaw rate (rate 
about Z axis) 

7 LSB/0.060975dps 

16-bit signed 2-3 Acceleration Y (gCFC60Y)1 
16 LSB/0.098g 4-5 Acceleration X (gCFC60X)1 

6-7 Acceleration Z (gCFC60Z) 
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1. Note channel order of YXZ is correct per FIA 8872-2018. YXZ means lateral, longitudinal, vertical, as would typically be expected from 
a vehicle coordinate system. 

2. Gyroscope field increments and decrements in steps of 7 LSBs, i.e. never will 4 LSBs be set for example, only 0, 7, 14, 21 etc. This 
CAN channel contains a nominal 0.35% error due to scaling, and resolution limitations of the CAN channels. This error is not present 
in event files downloaded from ADRs. 

3. Acceleration fields increments and decrements in steps of 16 LSBs, i.e. never will 9 LSBs be set for example, only 0, 16, 32 etc. 
Accelerometer calibration values are not applied to data broadcast on these channels, therefore these channels contain data 
accurate only to +/- 10%. These channels contain a nominal 2.1% error due to scaling, and resolution limitations of the CAN channels. 
This error is not present in event files downloaded from ADRs. 

 

 User Configurable MWL Trigger Message 

In addition to the standard FIA messages described above, the ADR supports 1 user 
configurable outbound message, used to control an external Medical Warning Light via 
CAN. 

To use the message, CAN must be enabled, and the ‘Enable Message Transmission’ option 
enabled underneath Medical Warning Light Message. 

The message is a CAN 2.0B standard length frame, with a single data byte. The message 
ID must be set to avoid ID collisions with other CAN traffic in the vehicle. 

The ‘Enable MWL Data Byte’ and ‘Disable MWL Data Byte’ are the values transmitted in the 
messages single data byte, that indicate when the MWL should be active, or not. Typically 
a value of 0, and 1 is used to indicate off/on, but they may be any value between 0-255. 
The device receiving and acting upon this message needs to be configured accordingly.  
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 CAN Protocol Faults 

The ADR features extensive diagnostic of faults related to the CAN system, at both the 
hardware and communication protocol level. Whilst all of these faults are described in ADR 
Utility where they appear, the CAN Protocol Faults require special attention. 

There are 2 types of CAN fault in particular that are particularly informative: period error 
faults, and timeout faults, displayed in ADR Utility with the following naming format: 

• FAULT_CAN_MSG_n_PERIOD_ERR (fault codes 65-69) 
• FAULT_CAN_MSG_n_RX_TIMEOUT (fault codes 71-75) 

Period error faults indicate that whilst CAN message traffic is being received, it is being 
received either sporadically, or at the incorrect frequency. For example messages may 
stop being received in short bursts, resulting in ‘windows’ of missing CAN data. 

Timeout errors indicate CAN messages have stopped being received altogether. In this 
case valid data may have been being received, until it stopped. 

The two types of faults can co-exist, which would indicate sporadic reception of CAN 
messages, followed by the messages no longer being received. 

 

14.3 RS-232 

A full duplex RS-232 port is provided, with robust electrical protection. This port allows the 
ADR to interface with any other device implementing RS-232. 

However, no software provision is made for this at the time of writing and is provided 
primarily as a requirement of the FIA 8872 technical regulations, which requires the 
inclusion of RS-232 hardware but prescribes no requirement for software support. 

However, custom functionality may be implemented upon request - please contact 
Emvexis to discuss your requirements. 
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15 Installation Instructions 

The ADR must be installed in accordance with the FIA Installation Specification for FIA-
Approved 8872-2018 Accident Data Recorders (ADR) document. 

The FIA specification controls almost all aspects of an ADR installation, except those 
specific to each manufacturer’s ADR. For the Emvexis ADR1, the following supplementary 
installation instructions apply: 

 

15.1 Orientation 

For the ADR to record acceleration and gyro data in the correct event data channels, the 
ADR must be physically installed within the vehicle in the orientation that the ADR is 
configured for. 

The vehicle coordinate system is defined by FIA 8872-2018 and is different from common 
automotive standards such as SAE J1733. 

The FIA coordinate system is in accordance with the image below. Positive values 
represent the direction the vehicle must be accelerated in along a given axis, for the 
recorded data to contain positive values. 

For example, a vehicle accelerating forward at a race start will capture positive X 
acceleration, and when braking into a corner will record negative X acceleration. 

Figure 23 - Accelerometer Channel Orientations 

 

https://www.fia.com/sites/default/files/8872-2018_accident_data_recorder_-_installation_specification_0.pdf
https://www.fia.com/sites/default/files/8872-2018_accident_data_recorder_-_installation_specification_0.pdf
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Gyroscope orientation is aligned such that clockwise gyro rotation when looking in the 
direction of an acceleration axis, results in positive gyroscopic data, as per the below 
image. 

 

Figure 24 - Gyroscope Channel Orientations 

 
The orientation of the ADR within the vehicle is fully configurable using the ADR Utility 
software, but is a restricted configuration parameter requiring authentication by passcode 
to perform the configuration. 

The orientation configuration ensures that regardless of the ADRs orientation within a 
vehicle, the event data channels always contain vehicle aligned data, not ADR aligned data. 
That is when properly configured, regardless of the ADRs orientation, the X axis 
acceleration dataset channel will always contain the vehicle’s X axis acceleration, not the 
ADRs X axis acceleration. 

In essence, the ADR itself does not have a coordinate system, per se. 

The ADR shall therefore be installed in the default installation orientation as shown in the 
image below, unless absolutely necessary, and only with written permission from the FIA, 
and the ADR configured accordingly. 
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Figure 25 - Default Installation Orientation 

 

 Changing Orientation Configuration 

As described above, only the FIA may configure the ADR installation orientation, using the 
tool shown below. 

Figure 26 - ADR Utility Configuration Installation Orientation 
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15.2 Mounting 

The ADR shall always be hard mounted within the vehicle. It does not require vibration 
isolation that is common with other electronics and will not record accurate acceleration 
data if not hard mounted. 

To clarify heading 4.1 within the FIA installation requirements, the ADR does not need to 
be isolated from vibration to protect the ADR, but it should still not be installed in a location 
likely to experience high vibration, purely due to the possibility of such vibration being 
included in recorded event datasets. 

For clarity, high frequency vibration is strongly attenuated by the ADRs internal hardware 
and software filters above 100Hz, but any low frequency vibration or ‘panel panting’ will be 
accurately recorded by the ADR. 

 

15.3 Fasteners 

The ADR shall be installed with 4x M4 mounting screws, at an installation torque 
appropriate for the hardware to which the ADR is being mounted. 

It is recommended to use ensure ≥8mm thread engagement into aluminium, or ≥6mm 
into steel. These guidelines are not definitive, as they depend heavily upon the design of 
the surrounding structures. 

Recommended fastener specifications: 

• Geometric standard: DIN 912 
• Material: Stainless steel A2-70 
• Length: 25mm (provides ~10mm fastener protrusion from ADR underside) 

Figure 27 - Recommended Fastener Length 
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15.4 Power Supply 

The ADR shall be powered from a DC voltage source between the minimum and maximum 
voltage limits defined in Table 2 – General System Specifications. It is recommended to 
fuse the power supply with a 0.5A fuse. 

The bare minimum electrical connections required are power and 0V. See Electrical 
Connector Pinout. 

 

15.5 USB port accessibility 

When the ADR is installed in a position within the vehicle where it can be easily accessed 
without tools, as per section 15.7, then a USB connection can easily be made to the ADR 
for the purposes of event download and configuration. 

If however the ADR is installed in a position where it is not normally possible to access the 
ADR, the vehicle must feature a USB 2.0 bulkhead type connector, connected to the ADRs 
USB pins, in a location which can be easily accessed, such as a bulkhead or dashboard. 

 

15.6 Connecting to CAN 

When connecting the ADR to the vehicle’s CAN network, the following points should be 
noted: 

• When using the ADRs software selectable, internal 120Ω termination resistors to 
terminate the CAN bus, the termination is only active whilst the ADR is powered 
and running. Termination is disabled during ADR firmware update 

• The ADRs CAN must be enabled within the ADR configuration before it will 
participate in CAN activity 

• The ADR will only accept the incoming CAN messages defined by the FIA regulation, 
although it will continue to ACK non-accepted messages in accordance with the 
CAN 2.0B specification 

• The ADR will only broadcast the CAN messages defined by the FIA regulation, in 
addition to one user configurable message used to trigger an external Medical 
Warning Light 
 

15.7 External Indicator Lights 

If the ADR is installed in a position such that the onboard status light is not visible, the 
vehicle must be equipped with 2 dedicated indicator LEDs: 
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• Status light, used to indicate general status of the ADR system 
• Medical Warning Light, used to indicate to medical personnel when an accident of 

a configured severity has occurred 

Both of these lights must be in a position that is normally visible to an FIA/ASN official when 
the occupant(s) is(are) seated normally and must be cleared marked ‘ADR Status’ and ‘ADR 
MWL’. 

The LEDs may be controlled by: 

• The ADR’s 2 constant current LED driver output pins, or, 
• A third-party device such as a Power Distribution Module, capable of receiving and 

interpreting information via CAN from the ADR, to set the light states 

The first option is strongly recommended, to mitigate the risk of misconfiguring third party 
systems, resulting in incorrect or non-functional indicator lights. 
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16 ADR Interface Cable 

The electrical connection of the ADR within a vehicle is the responsibility of the vehicle 
designer, builder, or operator as the design of the harness depends upon the functionality 
of the ADR that is used or not and where the ADR is positioned in the vehicle etc. 

However for simple interfacing with the ADR, Emvexis supplies ADR Interface Cables, which 
are simple USB male A, to the corresponding Deutsch/Souriau connectors detailed here. 
These allow you to perform all necessary functions, such as: 

• Configure the ADR 
• View diagnostics and fault information 
• Download event and configuration files 
• Clearing the Medical Warning Light 

The cables are available in a standard length under the following part number, and 
available in custom lengths on request: 

Length (minimum) Part Number 
3M PN-131 

 

The ADR connector is overmoulded onto the cable, in-house by Emvexis to produce a low-
cost, mechanically robust cable assembly. Only pins 7, 8, 9 & 13 are populated in these 
cables. 

The ADR is fully functional when powered only by USB using these cables, with the only 
restriction being the backup power supply charge rate is limited when on USB power only. 

 

Figure 28 - Standard 3 meter ADR Interface Cable 
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